Park County Re-2 Teacher Resource Guide
*This is a living document. Helpful information should be added and edited over time*

How to Use this Resource Guide: Click a topic in underline blue below to jump to a section.
Common Links for Teachers
CPR Class - Employee Training
Contact/Mailing Information
District Policies
District Forms
Duty - Morning, Lunch, and Bus
Driving Class - For Employees to drive students
Facility Use - Using shared facilities
Field Trips - Regular and walking field trips
Google Suite for Teachers - Docs, Forms, Sheets, Slides

o _The Gold Mine - Our Google Drive for Staff, Docs, Forms, Slides, Sheets

o Complete Gold Mine Google Drive How-To Guide
Keys - Access to the building
Loan Forgiveness
Paraprofessional Support
Phone - Landline in your room
Printer/Scanner/Copy Machine
Professional Development - Continuing Education, PD
Purchasing Resources - Requisition Form Submission Process
Security
Schedules and Calendars - Where to find them
School Meals
Student and Teacher Policies and Expectations - District handbooks, our ways of working
Syllabus - Examples and templates
Teacher Supplies
Trash Perks - Take out your home trash!
Who to Ask - Need help with something specific?
How to add new content to our Teacher Resource Guide - Continue building our district’s
collective knowledge and how-to, but keep it organized.

o Future Additions

m Committee Information
m School Contact and Mailing Information

Common Links for Teachers
e Park County School District - Very Important to click and explore what is offered. The lunch
menu is stored here.



https://www.parkcountyre2.org/

The Gold Mine Google Drive - The Google Drive to be used by all staff for the organization of
ongoing teacher collaboration, commonly referenced documents, building level information, and
more

o CLICKHERE FOR COMPLETE GOLD MINE GUIDE

e NWEA - Standardized Testing MAPS Data
o How-to: Training to be provided during staff meetings

e Alma - Gradebook, student information, incident reporting, class communication, more
Alma for Edith Teter Elementary

Alma for Middle School
Alma for High School
How-to: Training provided at new teacher orientation

o O O O

e Frontline - Find a substitute and check your leave days
o Logininfo provided by Admin Office
o How-to: Once logged in, follow prompts to view substitute request options and to submit
to your building principal for review
o Find an example of a detailed and appropriate Substitute Plan in _Gold Mine ->
_Templates -> Sub Plan Template

e AptaFund - Access your pay stubs

e MySchoolBucks - Talk to Food service about the best way to get a lunch account set up. This site
can be useful to make credit card/debit card payments for lunches.

e Planbook - Use for lesson planning and organization
o Online lesson planner - The district has paid for this subscription. You are expected to use
it. Log in information should be in your email account, if not, ask your principal.

o RANDA - RANDA Solutions - Performance Evaluation and Observations

e [ADDITIONAL LINK TITLES] - [Write a brief overview]
o [Paste actual link], edit text if needed to shorten the link.
o [Add additional useful information about the link]

CPR Classes
e Keep track of your own CPR course expirations. The classes have been offered online. Talk to the
Nurse if you need assistance starting these. It is mandatory for certain district employees. Ask
the Nurse for clarification if your role is in question. All staff going on field trips or any school
trips with students are required to have CPR training.

Contact/Mailing Information:

e School Number (Admin): 719-836-3111 e Physical Address: 640 Hathaway St. Fairplay,
e School Number (Preschool): 719-836-4416 C0O 80440
e School Number (ETE): 719-836-4421



https://drive.google.com/drive/u/1/folders/1PJz6lfv_AU4Aoc7w62ME1zFz79Wo_0yN
https://nwea.org/
https://ete.getalma.com/
https://spms.getalma.com/?_done=%2Fhome
https://sphs.getalma.com/
https://www.frontlineeducation.com/signin/
https://docs.google.com/document/d/1kk0W7WB-IKjWddorXObaDJbEH4b-P3m1/edit
https://www.aptafund.com/
https://www.myschoolbucks.com/ver2/getmain.action?clientKey=&requestAction=home
http://www.planbook.com
https://copms.randasolutions.com/account/login?ReturnUrl=%2F

e School Number (MS): 719-836-4406 e Mailing Address: P.O. Box 189 Fairplay, CO
e School Number (HS): 719-836-2006 80440

In order to make sure your package gets delivered correctly (either to the PO Box OR to the physical
address, you can add the PO Box number after the recipient’s last name and then put the rest of the
physical address into the shipping address boxes.

e Phone extension list

District Policies
e Please visit this link to view district policies.

District Forms
[ )

Duty - Morning, Lunch, and Bus
e Useful Docs: In _The Gold Mine-> Administrative Stuff -> (MS/HS)Lunch Duty Sign Up Sheet

e About: Teachers receive a 30 minute duty free lunch break. Sign up for lunch duty via the Lunch
Duty Sign Up Sheet. You may fill out a timesheet for compensation. Ask your principal for info.

e Responsibilities: As a duty teacher, it is your responsibility to monitor the students and ensure
their areas are cleaned up before they leave the lunch area. This will require walking the tables at
least once per lunch duty.

e While onrecess duty, do not allow students to be in areas where you cannot monitor them.
While on extra duty, do not be on your cell phone. Actively monitor students.

e ETE-teachers do not have morning, lunch or bus duty. ETE Paras do morning and lunch duty. All
teachers are expected to accompany students at recess and dismissal.

Driving Class

e Useful Docs: Gold Mine -> Transportation ->{DEVINSICIasSInion

e Mandatory driving class if you want to drive students for any reason. Ask the Transportation
Director for information regarding this class. ben.medina@parkcountyre2.org

Facility Use
e ‘You will need to request the use of shared facility space to use rooms such as the MPR,

Miner diner, and/or your classroom for any activity not directly related to your school day.
Examples include: awards, dances, parent meetings/nights etc.

e Request Principal Approval

e Fill out this form and send it to Billie Sites billie.sites@parkcountyre?.org and Principal.
They will either approve or deny your request. (When Jordan Sanchez returns from
Maternity leave, she will take this back over)

e Building use checklist

Field Trips

e Useful Docs: In_Gold Mine -> Student Involvement -> Field Trips Folder, you will find planning

templates, in addition to the forms mentioned below, to help create and execute a field trip. The



https://drive.google.com/file/d/1cCFN60weMi8yryu_PR16W2Kjm7OhEA_s/view?usp=drive_link
https://www.parkcountyre2.org/en-US/district-policies-1c94b1da
https://docs.google.com/spreadsheets/d/1NnRpbkoM0PO9ll5xPoTqWhNmHtgoROVCBkiTKrepaLg/edit#gid=0
mailto:ben.medina@parkcountyre2.org
https://docs.google.com/document/d/1Y5l8KNN7teKri_3CnBgRBBcoXll-EduG/copy
mailto:billie.sites@parkcountyre2.org
https://docs.google.com/document/d/1LM4Jy7xVNtp23DJNZaRF1hcffMiZ_ra-/edit

official district policy outlines all Field Trip information. JJOA-R-Field Trips outlines chaperone
requirements.

e Walking Field Trips - You need parent permission to take kids off campus. Consider having one
teacher per grade send out and collect for the team or send it home at the start of the
year/quarter depending on your class. Taking kids to the Java Moose, Family Dollar, Dollar
General or other merchants “just because” is not an appropriate use of a walking field trip. ETE
sends out their own form and the secretary can let you know whether all students have a signed
form or not.

e Field Trips - Educational opportunities can arise where you need a bus to take you out of town (or
even just across town). There are Field Trip packets in the main office. They include a permission
slip to fill out and send home with families as well as approval from the building Principal and the
Transportation Director (TD). The TD maintains a google calendar (must be logged into your RE2
Google Account to see) so you can see if they are already on trips when you are planning.

Google Suite for Teachers - We are a google campus. Please utilize Google products as much as
you can. Very few people have access to Microsoft Word/Sheets so when those file types are
sent out most CANNOT open them.
e Google Classroomi is also utilized a lot. Ask a fellow teacher for help. You can also
consider becoming a certified “Google Educator” to help you out with the Google Suite!

The Gold Mine - Our District Google Drive
e Whatisit? Aliving Drive for the organization of ongoing teacher collaboration, files we often

reference or search for in emails, templates to make your own, changing building level
information, meeting documentation, and more.

e Whatisyourrolein this and how is it to be used? Contribute to your area! Whether you are an
administrator, paraprofessional, or subject level teacher, we can share our accumulated
knowledge by adding our own useful files and information. See below for the Drive contents.

e Overview of Gold Mine Contents

o Administrative stuff - Lunch duty sign up sheet, payment schedule document

o Athletics - Team schedules, game schedules, more

o Band - Concert schedules, more

o Counselor information - Mental Health resources, Naviance lessons, Suicide resources
and Protocol, schedules courses, meeting with the Counselor, more

Departments/Subjects - Syllabus templates, onboarding programs, classroom ideas,

collaboration files such as progress tracking,

General Documents -

Professional Development and Continuing Education -

Standardized Testing

Student Involvement - templates for organizing common events such as field trips, pep

rallies, early release, templates for class sponsors

o Transportation -

o

o O O O


https://www.parkcountyre2.org/en-US/district-policies-1c94b1da
https://docs.google.com/document/d/1AeVmsNbyE2MNXSesVgpanjzaYll3tCfGwV-nGyf2XTY/edit?usp=drive_link
https://docs.google.com/document/d/1W-GIwcxdW5_cQteEn5Pl3DNTrbNK8LKHrQiHI3t9zP8/view
https://docs.google.com/document/d/1QEPAbG5FK9wqXS_zibGSg4uyO8ipEuwpU3r6e9bBvW0/view
https://docs.google.com/document/d/1QEPAbG5FK9wqXS_zibGSg4uyO8ipEuwpU3r6e9bBvW0/view
https://calendar.google.com/calendar/embed?src=c_j5u41d7q5u7kpqr0s3c6retpus%40group.calendar.google.com&ctz=America%2FDenver
https://edu.google.com/learning-center/certifications/

o Meeting space - A standardized, easy to copy meeting template, save meeting notes to
appropriate folders, discussions, and with organized follow up actions.

Complete Gold Mine Google Drive How-To Guide

Joining The Gold Mine Drive

Add existing files or folders that are open to editing and collaboration

Add existing files or folders without changing who has edit access. nor moving the location of
the original, editable file or folder.

Add files or folders that are saved to your computer that are not in Google Suite

How to make your own copy of a template or any file, and save it.

How to create a template
How to create shortcuts so you click less

How to edit offline
How to “pass the torch” of your work.

Joining _The Gold Mine Drive
o Anyone with a @parkcountyre2.org email domain has edit access and can share the drive
with you if they’ve been added before.
o Share the drive with someone by opening _The Gold Mine then click the pair of people

> _The Gold Mine ~ =&

and type in the @parkcountyre2.org of the
person(s) you wish to add.

o Once you receive the invite, open the drive, click the title of the drive “_The Gold Mine” ->
Organize -> Add to starred (Screenshot below). Now, you can easily navigate to the Drive
when you wish to move existing files or folders to it.
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3 New folder
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o To add existing files or folders that are open to editing and collaboration:
o Two ways todo this

1. Ifafile (Doc, Sheet, Form, Slides, etc) is open, select B nearthe top left of the
screen, then click the back arrow until you see “Starred” where _The Gold Mine
should now be located as in the previous step. Click within The Gold Mine until you
reach a folder of your choosing to move it there.

Drive X

@ My Drive B &

Computers
Lm P € Starred X

o Shared with me

* Starred > Go to _The Gold Mine folder

2. If you are viewing a file or folder from another Drive, click * next to the file or

_The Gold Mine

folder you wish to move-> Organize -> & ,and move to a Folder in _The Gold
Mine similarly as in the previous line. To select multiple files or folders to move at
one time, hold down the ctrl button and select all items you wish to move and
repeat above.

e Add existing files or folders without changing who has edit access, nor moving the location of
the original, editable file or folder. Use this if you'd like people to only be able to reference a file
or folder so they have the latest info, while you continue editing from your own Drive or original
space.

o Two ways todo this
1. Ifafile (Doc, Sheet, Form, Slides, etc) is open, click File -> then click

@, Add shortcutto Drive 1hen click the back arrow until you see “Starred”
where _The Gold Mine should now be located. Click within The Gold Mine
until you reach a folder of your choosing to add a reference link there.

Drive X
@ My Drive B &
. . Il
Computers
Ln : < Starred s

=% Shared with me

* Starred > Go to _The Gold Mine folder

2. If you are viewing a file or folder from another Drive, click * next to the file

A _The Gold Mine

or folder you wish to move-> Organize ->Click & Addshorteut (jicy

Starred -> and click within The Gold Mine until you reach a folder of your
choosing to add a reference link there. To select multiple files or folders to



add reference links at one time, hold down the ctrl button and select all
items you wish to move and repeat above.

e To add files or folders that are saved to your computer that are not in Google Suite
o Find the area of _The Gold Mine you wish to add the files or folders, by clicking within _The

File upload

+ New
[£) Folder upload

Gold Mine, then Click in the top right, then

e How to make your own copy of a template or any View Only file, and save it.
o Openthe file. Click File -> Make a Copy -> Rename as: [New Name] -> Click below Folder
-> Starred -> _The Gold Mine -> move into _The Gold Mine folder of your choice. (Or move
into a different Drive if you'd like) since it is now your own copy. See screenshot below.

Copy document X

Name

A File you Wish to Edit as Your Own

Folder
B Templates
P il memmbenrd i o e “aldas
Select a file x
.E:l Computers

. Shared with me

Yr Starred

o e

e How tocreate atemplate
o Name the file “[Name] Template”
o Ifit canbe used by anyone, move into _Templates in _The Gold Mine. If Department
specific, you can move into the folder you want.
o Paste the following at the top of the template:



m “Touse this template: Click File -> Make a Copy -> Rename as: [New Name] ->
Click below Folder -> Starred -> _The Gold Mine -> move into the folder of your
choice.” (Or move into a different Drive you'd like)

How to create shortcuts so you click less - For any folder, click i -> Organize -> Add to Starred.
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How to edit offline
o Click here to follow the steps for offline editing
How to “pass the torch” of your work.

o Todelete no longer needed files, click * , then Remove. Hold ctrl to click multiple files or
folders to delete.

o Make sure you've included useful selected files and folders to your area! Communicate
this to your principal so the next teacher has information they can use.

Google Docs - Google Docs Training | Teacher Center

Google Forms - Google Forms Training | Teacher Center

Google Sheets - Google Sheets Training | Teacher Center

Google Slides - Google Slides Training | Teacher Center

Google Calendar - A Teacher's Guide to Google Calendar

Google Classroom - Google Classroom Training | Teacher Center

Google Drive - How to use Google Drive - Computer

Issuing: You will be issued a key for your classroom and a key fob to access the electronic front
doors at the beginning of the year if you are a new teacher. Ask your building principal who can
help issue you keys and access as needed.

Access: Limited to certain doors. For the MS/HS the fob will usually grant access to the main
front door, burro plaza doors (by the MPR) and the back door by the art room.

What to do if lost: It happens! It is very important to contact your building principal immediately
so that they can deactivate the fob immediately.

Loan Forgiveness

After 5 years you may qualify! Open the link to learn more.


https://support.google.com/drive/answer/2375012?hl=en&ref_topic=14940&sjid=772816755478794976-NA#zippy=%2Csave-google-docs-sheets-slides-for-offline-use%2Cedit-offline-files
https://edu.google.com/for-educators/product-guides/docs/?modal_active=none
https://edu.google.com/for-educators/product-guides/forms/?modal_active=none
https://edu.google.com/for-educators/product-guides/sheets/?modal_active=none
https://edu.google.com/for-educators/product-guides/slides/?modal_active=none
https://blog.tcea.org/teachers-guide-google-calendar/
https://edu.google.com/for-educators/product-guides/classroom/?modal_active=none
https://support.google.com/drive/answer/2424384?hl=en&co=GENIE.Platform%3DDesktop
https://studentaid.gov/manage-loans/forgiveness-cancellation/teacher

Paraprofessional Support

The Exceptional Learner teacher will send out a paraprofessional schedule so you know when you will
have help in your classroom for IEP students. Students with a 504 won't need a paraprofessional often
(if ever), but paras are there to help support all kids, not just those on an IEP.

Phone/Intercom
e Checking your Voicemail - Press the voice mail button. Enter your extension number. #1212 is
the default passcode. To get your messages, press 2, to listen to them press 0. To delete, press *3.

e Making out-of-building calls - Dial 8 first, and then the number you wish to call. For emergencies,
itis JUST 911

® Phone extension list - NEEDS TO BE UPDATED

e Phone Manual

e Thereis ablack button in most classrooms that will intercom to the front office phones so you
can just talk to them without being attached to a phone (ie. it's an emergency). Get with your
building secretary and consider testing it before you need it. It can be a faster link to someone
for help and for kids to get help if something happens to the adult in the room.

Printer/Copier/Scanner Machine
e Some useful capabilities: Autostaple, auto hole punch, single or double sided

printing/copying/emailing scanned copies from the printer as a pdf. Ask anyone to show you how!
e For autostaple, auto hole-punch, and more...

o Click Print and ignore number of copies/page numbers from here -> Click more settings

and scroll down -> Click Print using system dialog... (Ctrl+Shift+P) -> click Finish and select

> |®™= Printing Preferences

Preferences ¥ My Tab Basic Layout Finish CoverMode Stamp/Composition Quality Other

Favorite Setting & Default Settil

Staple
p

Left Comer (Auto)

Find Printer

TR
@ Center Staple and Fold
o2l 33 []Punch

what you'd like to do . ST -> Click Ok ->
From here, enter the number of copies, and page numbers, and print.

e Color Copies - The office has a color printer. Color printing is reserved for special items and not
for everyday print jobs. Please ask your secretary to make colored copies for you as they are the
only ones with access to that printer. They will use their discretion of if they can print it for you
or not.

Laminator - Located in the ETE gym office. Don’t send kids - you have to do it yourself.
Students making copies - Very few students know how to make copies. As a general rule, don’t
let kids go make copies. They will definitely mess something up without adult help.

Reloading paper

What to do if problems arise



https://drive.google.com/file/d/1cCFN60weMi8yryu_PR16W2Kjm7OhEA_s/view?usp=drive_link
https://drive.google.com/file/d/1B5dS6Hz62V_rSu4uG0jDYnXrw6DRqI8K/view?usp=drive_link

e Best practices and etiquette

Professional Development

In _The Gold Mine-> Professional Development -> Course Credit and Pre-Approval Information
Taking something for Credit? - You will need to fill out a “Pre-Approval” form prior to taking the
course to ensure it will be accepted for salary increases. Grad courses numbered 500 or higher
will have to be approved by your building principal for salary increases. Turn in your transcripts
to Human Resources (Becky Keeling)

Credit Advancement Log - Make a copy and keep track of your own hours.

Payscale Lane Change Guide

Purchasing School Resources

Security

o You must fill out a requisition form (found at the front office or fill out and print a copy of
the form here), then submit to your building level principal for review. If approved, district
admin will assign a PO (purchase order) if necessary, or you can get a credit card to
process the payment after approval.

o Thedistrict has an Amazon account. Ask admin for access.

e Close and lock your door when you are not close by and when you leave for the night. Kids

should not be left unattended in your classroom. Close and lock your door from being open from
the outside while giving instruction and teaching.

Schedules and Calendars

o Current School Year Calendar
m District Website -> Calendars & News -> Current Academic Calendar
o Normal Day, Early Release, and Late Start Schedules
m In_The Gold Mine-> Counselor Info -> [HiEIERRIEIIE Navigate the tabs in this
Google Sheet to find the schedule you’re looking for. It includes Early Release
Schedule, Late Start Schedule, and Times for all the schedules.
m Access these schedules in Alma as well.
o Testing Day Schedules
m District Assessment Info. with hyperlinks
m In_The Gold Mine-> State Testing - >[iCstingochedule:
o Events - Athletics, after school district events, more
m Found on the district website here: District Events Calendar

. [& Calendar Sync o
e Click button on the District Events Calendar page to

add a calendar to your own.
o Staff Meetings - Look out for an email from your principal on time and days.

School Meals

e The menus are on the district home page.



https://docs.google.com/document/d/1iVoxE-bOg8WoYtSKQZyrTM-oar4in4c2kg3cxNWI3QA/view
https://docs.google.com/spreadsheets/d/1J_RPlud3LGdXPRyGQI7MUUehkP6ELjQGlx3osMeg9_0/copy
https://drive.google.com/file/d/1FznQJNHoVsn39CCNR2gv8k12BB0MbfHB/view
https://docs.google.com/spreadsheets/d/1AsYXal9TPZu4g1W14k8IFAawhFoQfMJWYIExndhDMy8/copy
https://docs.google.com/spreadsheets/d/1AsYXal9TPZu4g1W14k8IFAawhFoQfMJWYIExndhDMy8/copy
https://www.parkcountyre2.org/en-US#0
https://docs.google.com/spreadsheets/d/1Sy7sYOifbJXACcqbDy2ZPcQ7A2ns9OBGD0mHvipVAbE/edit?usp=sharing
https://www.parkcountyre2.org/en-US/assessment-information-9dc55020
https://www.parkcountyre2.org/en-US/calendar#
https://www.parkcountyre2.org/en-US

You can pay cash to the cafeteria to add money to your account or you can sign up for
myschoolbucks.com and pay via credit/debit card.

Alarge salad is SEISONSCNOONUNCHISHSIES]

Write your name on the pages by the cash register. If you're on lunch duty, write “LD” next your
name for that day only to be compensated for lunch. Indicate bfast if you're taking that in the
morning.

Student and Teacher Policies and Expectations

o Accessing the Student Handbook: District Website -> Students & Parents -> Student
Handbooks - Park County School District Re-2

o Accessing the Employee Handbook: District Website -> Human Resources - Park County
School District Re-2 -> Scroll to find “Current Employees” section -> Click Employee
Handbook

m Student Bathroom Breaks - MS/HS students severely overuse the bathrooms. A
good general rule is that you don’t allow them to leave in the first 5 minutes, during
the last 5 minutes, or during direct instruction. The easiest way to put off the
request is to tell them they need to do 5 more minutes of work or once they get to
problem #XX they can ask again. If it's an emergency - you will know!

m Passing Periods - Stepping into the hall during the passing period should happen by
all MS/HS staff. Be mindful of not letting your students into your room until you
give them permission - This encourages a break and restroom use, instead of doing
so during your class time.

m Outdoor Class Time - Treat the outdoor environment the same as you would your
classroom environment. Notify the front office of where you will be so they can
ensure they can find you. The nice days are limited in Fairplay. If you find it
appropriate to take your class outside, please keep them in one area.

m Contracted work hours - Per your contract you need to be at school by 7:30 am
and can leave at 4:30 pm. This includes early release days. If you need a day off,
use Frontline to request a sub. If it is the day of and you are ill, contact your
building principal ASAP. General Leave Policy

Syllabus

Here are some templates: Example 1, Example 2.

In_The Gold Mine ->_Templates -> Peruse the different syllabus examples -> Make a copy of one
to make your own. Check out the Google Drive guide in this document if you're unsure how to
make a copy.

Store your finalized syllabus in your department folder.

Teacher Supplies

The main office has the basics for TEACHER use - expo markers, tape, tape dispensers, pens,
scissors, paper clips, white out etc. There is also colored copy paper in the main office and
construction paper. These are not meant to be student supplies but rather supplies for teacher
use. If you need large quantities of glue, scissors, tape, posterboard etc please consider making a


https://www.myschoolbucks.com/ver2/getmain.action?clientKey=&requestAction=home
https://www.parkcountyre2.org/en-US/student-handbooks-647d8709
https://www.parkcountyre2.org/en-US/student-handbooks-647d8709
https://www.parkcountyre2.org/en-US/employment-fbf26a67
https://www.parkcountyre2.org/en-US/employment-fbf26a67
https://app.frontlineeducation.com/
https://docs.google.com/document/d/1qm7UCoaJL7zunJAi959z_arVr8Rqq5WPyAvXOx8bvtQ/edit?tab=t.0
https://docs.google.com/document/d/1Z4QtslYwPOlRchowtIlocK3Dc9Ro7jHkR6VkNmqa_Yo/edit?usp=sharing
https://docs.google.com/document/d/1X6GW2e7xWHjrfpRYWMJN2KfaLB_vGcQguQT6JyevcmE/view
https://drive.google.com/drive/u/0/folders/13l-cyBI4TGgAYLoQLORYyRaVl4Jvx6ua

requisition and house those materials in your classroom - don’t rely on the art department to
supply these either. Large butcher paper is available for use too. The middle school has arolling
rack and the art room also has some to use.

ETE Teacher supplies are in the Work Room next to the Front Office.

Trash Perks

You can dump your household trash at school on Thursday mornings if there is roomin the
dumpster.

Who to Ask

Extensive list updated by the District: District Website -> Human Resources - Park County
School District Re-2 -> Scroll to find “Current Employees” section -> Click Do
Gradebook Issues - Front office

Mental Health Resources - _The Gold Mine -> Counselor Info -> Mental Health Resources
Subject Level Specific Questions - Ask ANYONE in your hall! Everyone is willing to help you with
anything. Never hesitate or assume you should know something.

Other - Ask ANYONE in your hall! Everyone is willing to help you with anything. Never hesitate
or assume you should know something.

How to add new content to our Teacher Resource Guide

First, talk to someone in your building proficient in Google Suite if you are not fully confident.
Start by adding a new bullet point and title of the topic at the top of this guide under “How to Use
this Resource Guide” where the blue underline text is located.

Type a new header within the guide in the correct order relative to where you added a new topic
at the top of this document. Keep the text, font style, and size the same. Copy and paste this,
and replace with your header

Bookmark the header you typed within the document by: Highlight the header -> Insert
-> Bookmark.

Go to the top of the document and highlight the text you want as underline blue -> right
click -> Insert Link -> Select the header you bookmarked.

Now you can click the underlined blue text, and it will take you directly to the
bookmarked header.


https://www.parkcountyre2.org/en-US/employment-fbf26a67
https://www.parkcountyre2.org/en-US/employment-fbf26a67
https://docs.google.com/document/d/1xv3jMAbyi77eYkXcA32z0sBzknLKJep4IAw99tLwvOs/edit
https://drive.google.com/drive/u/0/folders/1Jt0Bx2jM7Oq7ni0U5QPvYnv96F8vdY9v

